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What is a Resume?

Hi! I'm Maria and this is Michelle.

.DIGITALLEARN.ORG

.l A PLA INITIATIVE




\,\
< - Skills

- Experience
- Education

Michelle is getting ready to apply for jobs so she needs to create a resume. A
resume is a written document that summarizes a person’s skills, experience and
education. It shows that a person is a good fit for a particular job opening.

Would you
come in for an
interview?

O

The purpose of a resume is to convince a potential job employer to offer a job
interview, and ultimately, to offer a job. We will walk Michelle through the

process, as she makes decisions about what to include in her resume, and what
format to use.
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Traditional
Functional

There are a few different approaches to writing a resume. The two main types of
resumes are the traditional resume and the functional resume. Your unique
experience as well as the specific job you are applying for will help determine the
type of resume that is best for you.

Traditional / Chronological

s will help the company prosper.

3/2008 - present Administrative Assistant, Nixon & Lindstrom Insuronce

10/2001 -
2/2008

A traditional resume is also known as a chronological resume. This type of
resume focuses on your work history, which is listed in reverse chronological
order.
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OBJECTIVE

+ Looking for a receptionist position where my strong communication and
organizational skills will heip the company prosper.

EXPERIENCE

3/2008 - present Assistant, Nixon & Li
« Excel in role requiring the ability to handle a variety of customer service
and administrative tasks and resolve customer issues with expediency.

in and fros within a

high-volume environment. Calm angry customers, research and rapidly
solve problems and rebuild dient trust to prevent loss of key accounts.
*Led cleanup of company database and files. Restored organization to
personnel, financial and jonal records and accelerated data input,
processing and retrieval ti

Receptionist, Ozarks Community Coliege

«Served as first point of contact for students, faculty and staff calling or
visiting the main administrative office. Efficiently operated campus
switchboard and provided prompt, courteous and knowiedgeable
assistance.

+ Transformed previously manual processes relating to vendor/supplier

This means that your most recent job is listed at the top, followed by older jobs.
Specific job duties and accomplishments are listed below each position. You
would use this type of resume when your most recent job history is relevant to
the current job with which you are applying.

MARY BAILEY

840 Boonvilie Avenue, Springfield, MO 65802 | 417-555-1212 | mbailey22 @gmai com

EXPERIENCE
Sﬁm-mm lixon & Lindstrom Insurance
- o . e ability to handie a variety of customer service
and administrative tasks and resolve customer issues with expediency.
. in and front-desk within a
high-vol i Calm angry research and rapidly
solve problems and rebuild dient trust to prevent loss of key accounts.

+Led cleanup of company database and files. Restored organization to
personnel, financial and ional records and data input,

processing and retrieval times.

10/2001 - , orks Community College

22008 eretrst point of contact for students, faculty and staff calling or
visiting the main administrative office. Efficiently operated campus
switchboard and provided prompt, courteous and knowledgeable
assistance.

. i manual relating to
records into an efficient, computerized system. Efforts exposed

In this example, the applicant is applying for an administrative position. Her most
recent job history includes similar jobs as a receptionist and as an administrative
assistant. Her work history is relevant to the current job she’s applying for. So
she has decided to use a traditional, chronological resume.
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uvier

ghield, MO 65721 | 417-555-1212 | pattybouvier@springnet.net

Objective

- Looking for a receptionist position where my strong communication and
organizational skills will help the company prosper.

Skills & Abilities

ADMINISTRATIVE

+ Typing speed 75 words per minute.

- Proficient with spreadsheets and reports.

- Able to manage calendars. meeting spaces. and other office coordination tasks.

COMMUNICATION

« Able to answer a high volume of phone calls courteously and professionally.
« Strong verbal and written communication skills.
- Conflict resolution skills.

Experience
CERTIFIED NURSING ASSOCIATE | MERCY HOSPITAL | 1993 - 2009

CERTIFIED NURSING ASSOCIATE | OZARKS COMMUNITY HOSPITAL | 1985 - 1992

A functional resume focuses on skills and accomplishments that can be pulled
from several different jobs.

uvier

gfield, MO 65721 | 417-555-1212 | pattybouvier@springnet.net

Objective

+ Looking for a receptionist position where my strong communication and
organizational skills will help the company prosper.

Skills & Abilities

ADMINISTRATIVE

+ Typing speed 75 words per minute.

+ Proficient with spreadsheets and reports.

+ Able to manage calendars. meeting spaces, and other office coordination tasks.
COMMUNICATION

+ Able to answer a high volume of phone calls courteously and professionally.

+ Strong verbal and written communication skills.

+ Conflict resolution skills.
by :
Experience

CERTIFIED NURSING ASSOCIATE | MERCY HOSPITAL | 1993 - 2009

CERTIFIED NURSING ASSOCIATE | OZARKS COMMUNITY HOSPITAL | 1985 - 1992

This is follow by a brief list of the positions, companies, and dates of your work
history.
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uvier

ingfield, MO 65721 | 417-555-1212 | pattybouvier@springnet.net
4 patty pring

Functional

Objective

- Looking for a receptionist position where my strong communication and
organizational skills will help the company prosper.

Skills & Abilities
ADMINISTRATIVE

~Typing speed 75 words per minute.
+ Proficient with spreadsheets and reports.

+ Able to manage calendars, meeting spaces, and other office coordination tasks.

COMMUNICATION
" Able to answer a high volume of phone calls courteously and professionally.
- Strong verbal and written communication skills.

+ Conflict resolution skills.

Experience

CERTIFIED NURSING ASSOCIATE | MERCY HOSPITAL | 1993 - 2009

CERTIFIED NURSING ASSOCIATE | OZARKS COMMUNITY HOSPITAL | 1985 - 1992

A functional resume focuses on your skills and abilities by placing them into
categories. Job titles and dates of employment are not emphasized. This is not
as common as the traditional resume but it may be a good choice if your recent
jobs do not relate to the position for which you are applying.

Patty Bouvier

100 Maple Street. Springfield, MO 65721 | 417-555-1212 | pattybouvier@springnet.net

work history # potential job

ion and

Skills & Abilities

ADMINISTRATIVE

+ Typing speed 75 words per minute.

+ Proficient with spreadsheets and reports.

+ Able to manage calendars, meeting spaces, and other office coordination tasks.

COMMUNICATION

+ Able to answer a high volume of phone calls courteously and professionally.
+ Strong verbal and written communication skills.

+ Conflict resolution skills.

Experience

CERTIFIED NURSING ASSOCIATE | MERCY HOSPITAL | 1993 - 2009

CERTIFIED NURSING ASSOCIATE | OZARKS COMMUNITY HOSPITAL | 1985 - 1992

In this example, the applicant is interested in a receptionist position but her work
history has been in the nursing field. Since her work history differs from the
current job she wants, she’s using a functional resume. She has listed her skills
and abilities that are relevant to the current receptionist job using categories. This
helps the potential employer see that she has skills relevant to the position even
if her previous jobs have been in a different field.
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Quiz

Michelle is applying
for jobs in the same
field as her work
history.

Click on the format
should she use:

Michelle is applying for administrative assistant jobs and has a recent job history
with receptionist and administrative assistant titles. Since Michelle is applying for
jobs in the same field as her job history, which resume should she use?
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If your answer is Traditional:

Traditional / Chronological

Contact

Objective

Job History
Job Title
Duties and accomplishments

Job title
Duties and accomplishments

Education

That’s right. Since Michelle has a work history that is closely related to what she
Is applying for, she can use the traditional, chronological resume format. This
format focuses on her job history and shows how her previous jobs have prepare
her to be a good candidate for her current job.
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If your answer is Functional:

Traditional / Chronological

Contact

Objective

Job History
Job Title
Duties and accomplishments

Job title
Duties and accomplishments

Education

Oops. Actually, a traditional, chronological resume format is the best choice for
Michelle. This is because her work history is closely related to what she is
applying for. The traditional format focuses on her job history and shows how her
previous jobs have prepared her to be a good candidate for her current job.
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MARY BAILEY

840 Boonville Avenue, Springfield, MO 65802 | 417-555-1212 | mballey22@gmail com

EXPERIENCE
3/2008 - present  Administrative Assistant, Nixon & Lindstrom Insurance

~ Excel in role requiring the ability to handle a variety of customer service
and administrative tasks and resolve customer issues with expediency.

in and front: ion within a

high-volume environment.
+Led deanup of company database and files. Restored organization to
financial and records and data input,
processing and retrieval times,

Receptionist, Ozarks Community College
+Served as first point of contact for students, faculty and staff calling or
wisiting the main administrative office.

+Transformed previoushy manual processes relating to vendor/supplier
records intoe an efficient, computerized system.

EDUCATION
2001 Bachelor of Arts, Missouri State University

1998 Associate of Arts, Columbia College

Whichever format you choose, your resume should include your contact
information, work history, details about your accomplishments, and your
education. We'll look at these sections in more detail in the next lesson.
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What to Include

skills:
Customer service
Resolving issues
Answerin Phoncs
Data entr

sPr‘cadshcc+9
Databases

A good first step in creating your resume is to think about the information you
want to include. It may be a good idea to gather information about past jobs and
to brainstorm lists of skills and accomplishments before you start typing your

resume on the computer.
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[MARY BAILEY |

| 40 Boonitie Avenue. Springfieid, M0 €802 Jla17-555-1212 | mbatey22@gmaitcom |

2001 - 2008 Receptionist, Ozari

Let’s take a look at what to include in each section of a resume. We'll start with
the contact information. The contact section is very important, so it is typically at
the top. It should include a name, phone number with area code, and an address.
It can also include an e-mail address. Be sure that your voicemail or answering
machine message is professional and appropriate.

MARY BAILE

840 Boonville Avenue. Springfield, MO 65802 | 417-555-1212 | mbailey22 @gmail com

v ]

h proven

' "'[RedHotRedh @gmail.com}

2008-present  Administrative Assistant, Nixon & Lindstrom

2001 - 2008 Receptionist, Ozarks Community College

You'll also want to be sure that any e-mail address you include is professional
and appropriate.
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MARY BAILEY

840 Boonville Avenue, Springfield, MO 65802 | 417-555-1212 | mbaidey22 @gmail com

[ mbailey@cxm:job.com ]

XPERIENCE

2008 -present  Admin N ndstr

2001 - 2008 Receptionist, O unity College

Don’t use an email with your current employer unless you have permission for
personal use of that account.

If you include an email address in the contact information, be sure to check your
email regularly, to see if you received any emails from potential employers.
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MARY BAILEY

840 Boonville Avenue, Springfield, MO 65802 | 417-555-1212 | mbailey22@gmail.com

SUMMARY

Experienced and results-oriented administrative professional with proven
3bilities in customer service and communication.

EXPERIENCE
2008 -present  Administrative Assistant, Nixon & Lindstrom Insurance

- Excel in role requiring the ability to handle a variety of customer service
and administrative tasks and resolve customer issues with expediency.

- in and front-desk reception within a

high-volume environment.

-Mdﬂmﬁmwumwﬂn mﬂovpnmnw
financial records al data input,

processing and retrieval times.

ks

ity College
- Served as first point of contact for students, faculty and staff calling or
visiting the main administrative office.

- Transformed previously manual processes relating to vendor/supplier
records into an efficient, computerized system.

The next section is often a summary or an objective.

MARY BAILEY

240 Boonville Avenue, Springfieid, MO 85802 | 417-555-1212 | mbailey22 @gmail com

EXPERIENCE

2008 - present Assistant, Nixon &

- Excel in role requiring the ability to handle a variety of customer service
and administrative tasks and resolve customer issues with expediency.
ies in and front-desk reception within a
high-volume environment_
- Led cleanup of company database and files. Restored organization to
financial and { records data input,
processing and retrieval times.

Receptionist, Ozarks Community College
- Served as first point of contact for students, faculty and staff calling or
vmummuhmmkmmm

mmmdﬁummmmmn

A summary briefly describe why you would be a great fit for the job. An objective
outlines your career goals.

.DIGITALLEARN ORG

A PLA INITIATIVE




2001 - 2008 Receptionist, Ozarks Community College

st point of

The summary or objective is typically used to highlight some of the strengths you
bring as a candidate. It is also very short in length.

MARY BAILEY

840 Boanville Avenue. Springfield, MO 65502 | 417-555-1212 | mbailey22@gmail.com

2001 - 2008 Receptionist, 0z0

The work history section is next. Here, jobs are listed in reversed chronological
order with the most recent job at the top. Keep the job you’re applying for in
mind, as you decide which positions to list, and how to describe them. Try to
cover several recent years of work history, and focus on the most relevant
experiences.
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MARY BAILEY

840 Bocnville Avenue. Springfield, MO 65802 | 417-555-1212 | mbailey22@gmail.com

SUMMARY

Experienced and results-oriented administrative professional with proven
abilities in customer service and communication.

EXPERIENCE
Im-ptgsm ive Assistant, NiXon & MO I

" Excel In role requiring the ability to handle 3 variety of Customer service
and administrative tasks and resolve customer issues with expediency.
- ies in and front-desk reception within 3
high-volume environment.
uddunupofcommdmbmvuiﬁes Restored organization to
financial and data input,

processing and retrieval times.

Receptionist, Ozarks Community College
- Served as first point of contact for students, faculty and staff calling or
visiting the main administrative office.

- i manual pi relating to
records into an efficient, computerized system,

For each job, you'll need to list the dates worked, job title, and company name.
Dates can be listed as a year without mentioning the month, but it makes sense
to include the month when the job is recent or only lasted for a short time.

MARY BAILEY

Springfield, MO 65802 | 417-5!

SUMMARY

Experienced and results-oriented administrative professional with proven
abilities in customer service and communication.

EXPERIENCE

2008 -present  Administrative Assistant, Nixon & Lindstrom Insurance, Springfield, MO

- Excel in role requiring the ability to handle a variety of customer service
and administrative tasks and resolve customer issues with expediency.

in and front-desk reception within a

high-volume environment.

- Led cleanup of company database and files. Restored organization to
personnel, financial and operational records and accelerated data input,
processing and retrieval times.

Receptionist, Ozarks Community College

- Served as first point of contact for students, faculty and staff calling or
visiting the main administrative office.

- i manual relating to
records into an efficient, computerized system,

Some resumes also list the city and state where the job was located.
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SUMMAR

2001 - 2008 Receptionist, Ozarks Community College

You'll also list job duties or specific accomplishments. This is typically the most
detailed part of the resume, and is the most time consuming to create. That is
why brainstorming skills and accomplishments in each job is a good way to start
when creating a resume.
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mp 3to5 tasks or |

accomplishments
Q = desctiptive but
concise

mp unique duties for
each position

Try to think of about 3 - 5 different tasks or accomplishments to write about. Each
statement should be descriptive but concise. You don’t want to repeat yourself or
include details that aren’t relevant. Try to list some unique job duties for each
position in your work history, even if jobs were very similar. You don’t want to list
the same things over and over.
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Action Verbs

Current job:
manages, develops,
assists, completes

Previous job:
managed, developed,
assisted, completed

When you are writing your job duties, think about adding a lot of action verbs.
These are verbs like manages, develops, assists, completes. If it's for a job
where you are still employed, use the present tense. If it's a previous job you
held, use the past tense like managed, developed, assisted, or completed.

3Na a0MINISTTatiVe Tasks ana resoiVe CUSTOMEN ISSUES WITN eXpealency.
- Demonstrate proficiencies in telephone and front-desk reception within a
high-volume environment.
company database and files. Restored organization to
personnel, financial and operational records and accelerated data input,
processing and retrieval times.

2001 -2008 Receptionist, Ozarks Community College
+ Served as first point of contact for students, faculty and staff calling or
visiting the main administrative office
- Transformed previously manual processes relating to vendor/supplier
records into an efficient, computerized system

EDUC (

2001 Bachelor of Arts, Missouri State University
1998 Associate of Arts, Columbia College
CERTIFICATION

2013 Microsoft Office Specialist

Next is the education section. Often a job will have an educational requirement,
and this section will allow you to be clear that you meet that requirement. If you
graduated high school more than a year or two ago, you wouldn’t typically list it
unless you don’t have additional education to list.
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G atIve tasks 3nd fe%one CLTomeT e te W D eateney

+ Demonstrate proficiencies in telephone and front-desk reception within a
high-volume environment.

» Led cleanup of company and files. ization to
personnel, financial and i records and acc data input,
processing and retrieval times.

Rec Ozarks C¢ ity College

+ Served as first point of contact for students, faculty and staff calling or
visiting the main administrative office.

+Transformed previously manual processes relating to vendor/supplier
records into an efficient, computerized system.

EDUCATION

2001 I Bachelor of Arts, Missouri State University I
1998 | Associate of Arts, Columbia College. |

CERTIFICATIONS

2013 Microsoft Office Specialist

Do list any schools you attended after high school, as well as the degree you
received.

ana a0MINISTTTIVE Tasks ana rESOIVE CUSTOMET ISSUES WITN eXpealency.

- Demonstrate proficiencies in telephone and front-desk reception within a
high-volume environment.

« Led cleanup of company and files. ion to
personnel, financial and {0 records and acc data input,
processing and retrieval times.

2001-2008  Receptionist, Ozarks Community College

« Served as first point of contact for students, faculty and staff calling or
visiting the main administrative office.

T manual pi relating to
records into an efficient, computerized system.

CERTIHICATIONS

2013 Microsoft Office Specialist

If you are currently enrolled in a school, you can list “Currently enrolled”, instead
of listing a date. You can also mention when you expect to graduate, listing for
example, “Anticipated graduation 2014”.

.DIGITALLEARN.ORG 10

.' A PLA INITIATIVE




3 BTIVE TaSKS aNa resoive CUSTOMEr ISSUES WITN exXpealency.

- Demonstrate proficiencies in telephone and front-desk reception within a
high-volume environment.

- Led cleanup of company datab and files. R d organization to
personnel, financial and operational records and accelerated data input,
processing and retrieval times.

Receptionist, Ozarks Community College

+ Served as first point of contact for students, faculty and staff calling or
visiting the main administrative office.

T i manual relating to vendor/supplier
records into an efficient, computerized system.

EDUCATION

| 2013 Microsoft Office Specialist |

I 2011-2012 Earned 30 credits in general education, Iﬁmrks Community College

I 2011 General Equivalency Degree, Fp\ringﬁeid, MO

If you attended high school or college but did not graduate, you can list the dates
you attended or the number of credits you received. You can also list a GED or
certificates and licenses that you've earned.

* Transformed previcusly manual relating 10
records into an eficient, computenied system

If you have many special certifications in your field, you may want to create a
separate section for them.
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Using a Template

—
Y E

Microsoft Word

Let’s take a look at creating a resume using Microsoft Word. One advantage to
using a program like Word is the availability of templates for certain kinds of
documents, including a resume. Since resumes use complex formatting, it can be
a lot easier to use a ready-made template in Word.
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Michelle has already opened Word which shows a blank document. To find a
Word template, Michelle clicks on the File tab,

then clicks on New.
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Take a
tour

Title (3] Title Title Title

This brings up a gallery where we can browse for templates. Many types of
documents are listed here but we can search for what we’re looking for using the
search box. In the case of resumes, there is already a suggested search for
resumes.

I"JEW
-]
O :
Take a
tour

Title (=} Titte Title Title

e

Michelle can just click it to bring up the resume templates.

A PLA INITIATIVE

. DIGITAL .ORG 3
.'



1

[ el

= Cotwgery

ft

—
% [

Mery

oo Yo
e

Poema

it T 4 o e o
- Owegn S
[Sre—-

Sobma
L e
P

Lo e

A

Some of the resume types are traditional, some are functional, and some have
been made for specific types of jobs. Michelle clicks on a resume to bring up a
larger preview.

Arrow through options

Then she can click on the left and right arrows to cycle through the other
templates.
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Chronological resumse
{Simple design)

B L
e e b e L T L
D i e T

L B I R T

Resume {color)

S

[ e e L o= =
s i Y n ¢ gt e

Since most employers skim through resumes in a matter of seconds, it’s best to
choose a design that is clean and simple. It is recommended to stay away from

templates with lots of colors and lines.
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Michelle decides on a simple template and clicks on create.
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Once the template is opened, Michelle is able to fill in her own information. To do
so, she just clicks in each field and types over what's there.

B I U%-A-:iZ-Ii=- sye

NAME |

When Michelle clicks in the name field, the current text is highlighted. Once the
text is highlighted, it can be replaced by simply typing over it. Michelle types out
her name,
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EE T
MICHELLE MARTINEZ

ode] | [Telephone] | [Email]

SUMMARY

Check out the quick tips below to help you get started. To replace tip text with your
own, just click it and start typing.

COMPUTER SKILLS

Languages

- Need another skills, experience, or education entry? You got it Just click in the last
sample entry for the section you need and then dick the plus sign that appears.

Software

- On the Design tab of the ribbon, check out the Themes, Colors, and Fonts galleries to
get a custom look with just a dlick.

EXPERIENCE

then she types out her address,

B
«MICHELLE MARTINEZ

7:unw:y,spmgﬁeu,mos75n||(wl

SUMMARY

Check out the quick tips below to help you get started. To replace tip text with your
oown, just click it and start typing.

COMPUTER SKILLS

Languages

- Need another skills, experience, or education entry? You got it Just click in the last
sample entry for the section you need and then click the plus sign that appears.

Software

+ On the Design tab of the ribbon, check out the Themes, Colors, and Fonts galleries to
get a custom look with just a dlick.

EXPERIENCE

phone number and e-mail address. Just by clicking in each field, highlighting it,
and typing over.
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MICHEL

im

LE MARTINEZ

17-555-1212 msmartinez@gma;

d, MC

Check out the quick tips below to help you get started. To replace tip text with your
own, n%dnck itand start typing:

COMPUTER SKILLS

Languages

Next Michelle comes to the summary section, as with the other areas of the
template, she can just click into the area, and then type in any text.

COMPUTER SKILLS
Languages
+ Need another skills, experience, or education entry? You got it. Just click in the last
sample entry for the section you need and then dlick the plus sign that appears.
Software

- On the Design tab of the ril ‘check out the Themes, Colors, and Fonts galleries to
get a custom look with just a cli

EXPERIENCE

[Dates]

[Dates)]

Michelle decides not to list any computer skills so she needs to remove this
section of the template. To remove this section, she clicks and drags over the
section to highlight it. Then she presses the delete key on her keyboard to
remove the section. You can delete any section in a template that you don’t want

to use.
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FEXPERIENCH

[Dates]

" [Dates] [Job Title], [Company]
This is the place for a brief summary of your key responsibilities and most stellar

u
accomplishments. h

[Dates] [Degree Earned], [School]

[Dates] [Degree Eamed], [School]

In the work history section, Michelle will continue to click and type in each field.
Michelle wants to include a third job, but the template only has fields for two jobs.
To add a third job to the template, Michelle clicks on the second job to select it,
and a plus sign appears on the right. Michelle clicks on the plus sign and fields
for a third job are added.
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Oates]

Dates) {Degree Lamed], [Schox

Dates] {Degree Lamed), [Schox

Michelle will continue to fill in the template by clicking in each field and typing in
the information. After she’s done, Michelle will be sure to save her resume. If you
would like more information on saving documents, or more on using Microsoft
Word, visit the beginning Microsoft word class on this site.
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Resume Tips

Employers look through many resumes for each job. Sometimes, hundreds. This
means they lack time to scrutinize all the resumes that they receive. In fact, they
may only scan your resume for less than a minute.

A PLA INITIATIVE
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Tips

e Content - what you've
written
e Design - what it looks like

J
\/

g

The following tips may help to make sure your qualifications shine through. We’'ll
cover some tips related to content, or what you’ve written in your resume and
then we’ll cover some tips related to design, or how your resume looks.

—_——
Content tips

1.Use keywords; customize.

Ouir first tip is about keywords. When you're writing your resume, use good
keywords that will attract the eye of the reader as they scan. This will allow them
to quickly see your qualifications for the position. Also, your resume could be
screened using computer software before a person views it. In this case, having
the right words become very important.
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Job Duties

Draft, review, and edit
documents with accuracy;
accurately create, maintain,
update, and report on
confidential requests,
databases, special projects,
files, and correspondences.

One strategy is to use the actual words and terms that are included in the job
advertisement. Let’s look at an example. Michelle is applying for an
administrative assistant and the job ad lists the duties shown on the screen.
What are some keywords that Michelle might use in her resume that match what
the employer is looking for?
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Job Duties

Draft, review, and edit
documents with accuracy;
accurately create, maintain,
update, and report on
confidential requests,
databases, special projects,
files, and correspondences.

The job duties listed include the ability to draft, review and edit documents. It also
talks about creating reports, using databases, and writing correspondence. If
Michelle has experienced any accomplishments related to these duties, she
would be sure to include them in her resume for this position using these
keywords from the job duties.

Job Duties

Draft, review, and edit
documents with accuracy;
accurately create, maintain,
update, and report on
confidential requests,
databases, special projects,
files, and correspondences.

Also, the duties listed mention the importance of accuracy and the importance of
confidentiality in this position. Michelle will also consider using these keywords as
she describes her past experiences.
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Content tips

1.Use keywords; customize.
2.Be concise.

The next tip is to be concise. Since a potential employer will be scanning your
resume, unnecessary and redundant words will get in the way. Cut out as many
words as you can while still providing the necessary information.

Maintained the €hrefExecutive-Officer's
calendar, including planning and scheduling

meetings, ptarmmmgard-scheduatimg-

teleconferences, and nrakimg travel
arrarngenTerTts.

Maintained the CEO's calendar--planned and
scheduled meetings, teleconferences, and
travel.

Let’s look at an example of what Michelle has written about her job experience.
Are there changes we can make? There are words we can cut out to make this
more concise. Here’s one possibility. We've use the common acronym for Chief
Executive Office, CEO. We’ve also cut out some of the redundant text. Then
we've used a dash to cut out a few more words. As you can see, the resulting
text is much more concise.
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Content tips
iv

Tip number three is to be truthful. It's not a good idea to lie on your resume. It
can be very tempting to stretch the truth about our experience when we'’re
interested in a great job for which we have many of the qualifications but not all
of them.

1.Use keywords; customize.
2.Be concise.
3.Don't lie.

P =3

{

Content tips

1.Use keywords; customize.
2.Be concise.

3.Don't lie.

4 Exclude personal info.

Tip number four is to leave out personal information.
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20/2003 = Receptionist, Cravks Community Collepe

If hobbies and interests, volunteering, religious and political affiliations, and other
personal interests are not directly relevant to the job, don’t include them. You
also want to exclude any information on your age, height and weight, or marital
status. This kind of information gets in the way of pertinent information, and is not
appropriate in most job seeking situations in the United States.

Content tips

1.Use keywords; customize.

23 2.Be concise.
~ 3.Don't lie.
4 Exclude personal info.

5.Proofread.

The final content related tip is to proofread your resume. Typos and misspellings
might communicate to a potential employer that you don’t pay attention to detail.
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AFERIENLCE
3/2008 - present A‘L"‘,lUL‘JL‘LVSA‘w"{""W Insurance
dministrat custon sues with expedic
monstrate g ne and 11 | )

onnel, financal and operational recocds and accelerated data input,

processing and retrieval times

10/2001 - Receptionist, Ozarks Community College
2/2008

d as first point of contact for students, faculty and staff calling or

vistting the maen administrative office

« Transformed previously manual processes relating to vendor /supplier

If you're using a computer to create your resume, be sure to make use of any
available spell check function. Programs like Microsoft Word usually bring known
misspellings to your attention by including a red underline under the misspelled
word. If you right click on a red underline word, a pop-up with suggested correct
spelling comes up, which you can just click on to correct your spelling.
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there, their, they're

your, you're

>
Q
T threw, through, thorough

Spell check can miss words that are spelled correctly but that aren’t correctly
used. Here are some examples of words that are commonly used incorrectly on
resumes, which wouldn’t be caught by a spell checker. For this reason, it's good
for you to proofread yourself and also, have a friend or colleague proofread for

you too.

Design tips

1.Use traditional fonts.

O

Let's move on and talk about our design tips. Number one is to use traditional
fonts.
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EXPERIENCE

2000 -
present

Ascistant. Niwow & Lindstrom bnswrsne

requtring the altity Lo handic 3 varurty of castomer service and
rative Lanks and resshe customer insuce with mpadency.

proficiencies in telephone and front-dest recaption mithin &

ry database and Nes. Koolored srganciation to
pernornel, Nmancial and operationsl records and sccelersted data nput.
procesaing and retrieval times

1N2001 - Recegtiontss, On

s imes New Roman

Vieiting Tha mun )

-1 Tahoma

records Lo an oif

Georgia
EDUCATION Calibri
2001 Bachelor of Arte, M -
1996 Associute of Arte, Cohmmbis Cologe

While it might seem tempting to use fonts that appear more unique or decorative,
this is a bad idea, unless you are a designer applying for a design related job.
Stick to the more common fonts like: Times New Roman, Tahoma, Georgia or
Calibri. Also, it's a good idea to use only one or two fonts and no more than two.

—_—
Design tips

1.Use traditional fonts.
2.Include white space.

The second design tip is to incorporate white space into your resume.
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Sometimes it's a good idea to look at your resume from a little far away, so you
can’t read the words, but you can still see the dark blocks of text. Is there any
white space you can see? In this example, there are just blocks of text, and very
little white space. A resume with no white space can be overwhelming to look at
and hard to read. If we're concise when we write our resume, and if we make use
of bullet points, we can be sure to have room for some white space. In this
second example, there’s more space in the margins and between the sections.
This is easier on the eye and allows the reader to make notes in the margin if
needed.
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Design tips

1.Use traditional fonts.
2.Include white space.
3.Exclude images.

The third design tip is to exclude any images.

Mary Bailey
$40 Bocerville Avenwe, Springfaeld, MO 65807

478551212
mbailey22 Ggmail com

Objective

Looking ptionist position wheee my strong
4 2500 and organizational skills vwall help the CoOmpany prospet

You don’t want to include a picture of yourself unless you are specifically asked
for it. You also don’t want to include any clipart, decorative borders, or other
images.
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Design tips

1.Use traditional fonts.
2.Include white space.
3.Exclude images.

4. Make headings stand out.

The next design tip is to make headings stand out. This allows the reader to
easily scan to the sections of interests.

MARY BAILEY

L e L

372008 « presert  ASwanitrptive AdSRast, Naon § Listatrom Msrance

In this example, the headings use larger text and they use all uppercase letter.
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Design tips |

1.Use traditional fonts.
2.Include white space.
3.Exclude images.

4.Make headings stand out.
5.Check for consistency.

The final design tip is to make things consistent.

Patty Bouvier

100 Ma

Objective
LGoking ToF 2 rece;
ergamizational th

et Springfield. MO 65721 | 417:555-1212 | pastybourier

ptice
¥

Experience
CERTIFIID NURSING ASSOCIATE | MERCY MOSPITAL | 1993 - 2009

CERTIIED NURSING ASSOCIATE | OZARKS COMMUNITY HOSPITAL | 1985 - 1992

For example, make sure the headings are all the same size, especially if you
have more than one level of heading. You also want to be sure all the text is
using a consistent font, type, and size. If you are using periods at the end of
bullet points, be sure every bullet point has a period. If you don’t use periods,
that’s fine too. The point is to make sure it’s all consistent. Making sure your
resume is consistent throughout will help make it look as professional as

possible.
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